
Student Assistant Techs 

Student technicians are responsible for four main areas of expertise in our concert series, for external 

clients and providing recording services to students.  They are:  

 Audio Recording 

o Concert archive recordings 

o Audition recordings 

 Video Recording 

o Concert archive recordings 

o Audition recordings 

o Special projects (promotional/recruitment) 

 Projection 

o Stage Lighting design 

o Multimedia projection 

o Screen set up 

 Live Sound Reinforcement 

o Audio playback 

o Voice and instrument amplification 

Some things can be learnt in a single session, and some things need to be structured in a progressive 

way.  Projection is easiest area to master, with audio being second, live sound reinforcement third, and 

video being the hardest (not least because it requires having mastered audio recording too).  Live sound 

isn’t really hard, but it is high pressure, often requiring quick thinking, so we’ll consider it to be harder 

than audio recording. 

Your training will take you through each area of expertise as your time commitment allows – the more 

areas of expertise you have, the more shifts you’ll be able to take.   

Support is provided in all areas throughout your time here – you are always welcome to ask for advice 

on how best to tackle a particular task or job.  

As you progress through the training for each area of expertise, you’ll have opportunities to use your 

skills in real performances. We audio record ALL Music at Memorial concerts, video record at least four 

per semester and handle multiple audition recordings for students – these normally consist of soloist 

and accompanist, and generally use a more complex set up for audio than the typical concert set up but 

a simpler video set up. Live sound gigs are less common with around 10-15 per year, ranging from a 

single microphone, to miking up an 18 piece band. Projection set up is even more rare, but thankfully, 

very easy to learn. Special lighting set ups are also quite rare, but straight forward. You’ll build your 

confidence, abilities and experience as you progress and while you might not always be inside your 

comfort zone, we’ll never push you further than your capabilities and training have taken you. 

What we need in our techs is attention to detail, sound listening and seeing skills and a good attitude.   

  



BEFORE YOU START – CORE RESPONSIBILITIES AND OBJECTIVES 

There are several reasons to have a list of rules, responsibilities and objectives.  They safeguard the 

school’s reputation and investment in equipment, and help to avoid awkward situations for you among 

your peers and the school’s clients.   

At the basic level, being a tech is about safety for you, the performers and the audience.  At the 

advanced level it is about having a concept of sound reproduction – this is a subjective thing that can 

only be learned through experience, exposure and exploration. Regardless of what level you’ve reached 

in the subjective world of good sound production, you must think about safety and security of 

equipment, and everyone who comes in close proximity to it.   

1. Treat all equipment with care and respect – equipment is expensive to replace, and in many 

cases, the school is unable to sustain a replacement program of equipment that gets damaged 

beyond repair.  Equipment is intended to work effortlessly as part of the overall system.  If you 

have to force something, chances are good you’re doing something wrong, and chances are 

good you’re going to damage something.  So STOP, and think about what you’re doing.  

Microphones are particularly delicate.  Treat them with care, and whenever you’re handling 

them, put your concentration into what you’re doing.  Not concentrating can easily result in 

drops which are usually fatal to microphones.  Most of our recording microphones are worth 

over $500 each, some are worth more than $1,000.   

2. All sessions must be booked through the Concert and Facilities Coordinator. Even pro-bono 

sessions must pass through our booking system so that we can keep track of room and 

equipment usage.  I would recommend not getting into the habit of offering free recording 

services for friends because it can easily put you in an awkward position of having lots of work 

for which you’re not being paid.  However, it is acceptable in isolated cases. You must not in any 

circumstances get paid directly by individuals for service unless you are using ALL your own 

equipment to do so.  If you’re using the School’s equipment and facilities, you must be paid 

through the student assistant program. 

3. If equipment gets damaged, report it immediately to the Music Technologist.  If you discover 

damaged equipment, report it also.  We can’t fix it if we don’t know it’s broken!  All damaged 

equipment creates a hazard. 

4. Be especially careful of trip hazards when setting up.  Cable runs must be tidy and secure in 

order to avoid trip hazards.  Avoid stretching cables and running them where they are not able 

to completely trail on the floor.   

5. Don’t phone it in...   if you’re not trying to create the best quality product you’re capable of, 

you’re doing a disservice to the people you’re working with and to the School’s reputation. 

6. Know what service the school of music has agreed to provide.  If you are being asked to provide 

something that is out of the scope of the services we offer, or that jeopardize safety by not 

utilizing enough people to do the job properly, address this with the Music Technologist or the 

Concert and Facilities Coordinator. 

  



Four track audio recording in D F Cook Recital Hall 

EQUIPMENT YOU’LL BE USING 

Steinberg MR816x – the MR816x is an audio interface - an essential part of any computer based audio 

recording set up, and is the component that allows us to send our audio recordings from microphones 

to the computer, and from the computer to our ears. The MR816x is like a high quality sound card. 

Neumann KM184 microphones – hanging from the ceiling in Cook Hall, just in front of the stage, are 

two Neumann microphones set up in an arrangement called ORTF.  ORTF is a very commonly used 

stereo miking technique for ensemble recording that gives us a realistic representation of our sound 

stage. 

Neumann KM183 microphones – hanging from the catwalk outside the soundbooth are two Neumann 

microphones set up in a spaced arrangement, commonly referred to as A-B. These microphones are 

placed to pick up the audience applause, and the ambient reverberation from the hall.   

Cubase – Cubase is a DAW (Digital Audio Workstation). All computer based recording systems are called 

DAW’s. We use this to record our audio, and to edit and mix in Cook Hall.  In Suncor Energy Hall, we use 

Nuendo which is Cubase’s brother.  They look almost identical, and work in the same way.  Their files are 

even interchangeable, so a project started in Cook Hall can be finished in Suncor Hall and vice versa.  

These products are so alike, they are affectionately known throughout the audio industry as Cubendo 

(Cubase-Nuendo…). 

OTHER IMPORTANT TERMINOLOGY 

Before we move on, let’s just go through a quick description of terminology you may come across in the 
text. 

Stereo Pair - refers to the two microphones hanging from the ceiling in an ORTF formation. 

Monitors - The speakers that we use to listen to material being recorded or played back through the 
recording system. Any reference to monitors in this article refers to the speakers. The computer monitor 
will be referred to as the screen. 

Bounce - this is the process of mixing down several audio tracks in Cubase to a stereo (two track) file, 
which makes it compatible with CD players, MP3 players and any other media player. 

Patchbay - the central point at which we connect our recording equipment to our microphones. There 
are patch bays below the stage, in the sound booth and at the back of Cook Hall. 

XLR - A standard connection for audio components in a recording system. It is used to connect 
microphones to our audio interface, and our audio interface to our 
speakers.  XLR cables are also used in live sound set ups. The connection 
has a male and a female end and they click together. The male end has 
pins, while the female end has holes.  Normally, audio signals are SENT 
through a male connection and RECEIVED through a female connection, 
though this isn’t always the case. 

 



Clipping - When the signal reaches a point called zero, it has clipped. Digital audio is a description of 
audio characteristics as a number and unlike analogue, cannot physically exceed zero. The result is that 
anything that goes above zero gets cut off, and this is heard by significant distortion to the sound which 
can't be removed in editing. So, it needs to be avoided. Use the metering within Cubase to determine 
correct levels to avoid clipping. 

HOOKING IT ALL UP 

Connecting the components together is straight forward, and most of the time, will already be done for 

you.  The only component which might not be ready to roll is the connection from the microphones to 

the Steinberg MR816x.  If the microphones have been used with another system prior to your arrival, it’s 

possible that they are no longer connected to the MR816x.  

The picture below shows where the connections come into the sound booth from the hanging mics. 

They’re on the left wall as you come into the sound booth.  There are only four connections on the really 

old blue metallic rack have any relevance to us.  Those are labelled STEREO PAIR (labeled in this picture 

as ORTF Mics and CATWALK MICS.  

 

When I explained what XLR connections are above, I said that MALE normally sends, and FEMALE 

normally receives an audio signal. Here is one of those exceptions!  We are expecting the wall connector 

to be a Male connection, since it will be pushing the signal on, but it’s actually a female connection. The 

sound booth was wired long before my arrival at the School of Music, and I have no idea why it was 

done this way. In order to enable us to connect to other equipment, we need to correct the gender of 

the connections using a TURNAROUND cable, or a GENDER CHANGER. This gender change, can be made 

at any point along the chain of cables, but is at some point necessary if we are connecting to any 

manufactured equipment. 

The other end of the cable run here needs to connect to the back of the MR816x - MIC/LINE INPUT 3 

(left) and 4 (right) for the Stereo Pair, and 5 (left) and 6 (right) for the Catwalk pair. 



 

 

...and this is the cable you use to connect.  Note 

that it already has the male XLR connectors so 

you don’t need to worry about a turnaround 

cable. 

 

 

 

 

With the connections made, we now need to turn on the equipment, if it’s not already on.  It’s 

important that you follow the correct order – partly to satisfy the finicky nature of it, and partly to 

protect the equipment and your hearing. Turning on the speakers before everything else can often 

result in loud bangs when other equipment is subsequently powered up.  So, its most important that 

speakers get turned on last, and get turned off first. Failure to do so may permanently damage the 

speakers, and if you’re too close to them when it happens, can also affect your ears.  You’ve been 

warned! The MR816x  likes to be turned on before the computer is booted up.  If its already powered up 

when you arrive as is often the case, cycle the power (turn the box off, then back on again), to reset the 

device.  The power button is located on the front right. 

Next, turn on the computer.  Once it has booted, you can turn on the speakers (power buttons on the 

back of each speaker).  You may prefer to use headphones, in which case, plug them into the front of 

the MR816x just to the left of where you plug the headphones in.  When you’re finished, power down 

the speakers.  Please leave the computer and interface turned on.  

RECORDING WITH THE MR816x 

Above, you’ll recall that we connected our stereo pair microphones to MIC3 and MIC4, and catwalk pair 
to MIC5 and MIC6 on the back of the MR816x. On the front of the interface, is a knob that controls the 
amount of amplification of the microphone signal – the pre-amp gain for each input channel. Experience 
will guide you to where these knobs need to be for various types of groups that you will record.  The 
quieter the group, the more pre-amp gain you’ll need.  We aim not to change the level of gain during a 
performance, so you need to know what kinds of groups are performing, and adjust for the loudest one.   

The good quality of our equipment means we don't have to push the pre-amps hard. If we record at a 
level that is too low, it doesn't matter too much... well, as long as it’s not too, too low. If the meters in 
Cubase show clipping when you record, you need to turn these knobs down (you’ll find out the signs of 
clipping as you read on...). The knobs for MIC3 and MIC4 should be at the same levels as each other 
when you're recording using the stereo pair to get a balanced sound that accurately represents what is 
happening on stage. Similarly, the knobs for MIC5 and MIC6 should also be at the same level as each 
other. 



If you’re wondering why we don’t use MIC1 and 2 for our inputs, its simply because the connections for 
these two channels are on the front of the interface, and the cables are more likely to get in our way if 
we use these connections. 

CUBASE BASICS 

Cubase and Nuendo are very complex applications, and it certainly wouldn't be practical to go through 
everything. For the purpose of this session, we'll just go through the basics of how to set up a session 
and how to record a session. Later, we'll cover them in a little more detail, but this is all we need for the 
purpose of recording concerts. We’ll just refer to Cubase from here on, but the same applies to Nuendo 
when you get to use that. 

SETTING UP 

So, in the previous page, we went through the process of setting up the hardware. Now we need to go 
through the process of setting up the software. 

1. Double Click the Cubase icon on the desktop, or single click the icon on the taskbar.   
2. You will be greeted with an Open Document Options dialog.  Choose New Project and click OK. 
3. You will next be greeted with a list of templates that you can use as a basis for your project.  

Choose Cook Hall Basic Concert and click OK. 
4. Next you need to choose a Project Folder.  This is where all your audio files and project files will 

live.  Use the D drive (called AUDIOFILES), and then your personal folder, then click the New 
Folder button. 

5. Type a name for your project and use the following naming convention –  
YYMMDD – Project Name 
YY = Year, MM = Month, DD = Day 
For example – 120730 – Project X 

6. Now your project will open.  You’ll probably see a couple of windows including the main project 

window with a timeline and possibly a mixer window.  At this point, your project is not yet 
saved.  Go to File > Save As, then type a name for your project.  It will already be in the 
folder you created in step 5, but for the purpose of easy finding again when you need it, 
give your project the same name (eg, 120730 – Project X), and hit Save. 

Next, you need to check the project settings and make sure they are suitable for what you are doing. For 
most of what we do, you’ll be recording using a Sample Rate of 44.1Khz and a Bit Depth of 16 Bit and the 
Basic Concert project template includes these settings.  This allows us to put our files straight onto an 

audio CD without having to do any conversion.  Sample rate is the 
number of audio snapshots taken each second (in this case 44,100) 
and the bit depth is the resolution of dynamic range, or the number 
of volume steps available from quietest to loudest (in this case 
65,536).  

You can check/change this information by going to Project > Project 
Set up.  Get into the habit of not changing these figures once you 
have started recording a session.  This could give you some 
complicated problems to figure out later!  If you record using the 
wrong settings, there are ways of changing it in post production that 
are better than changing the settings after you have started 
recording.  We’ll deal with that separately to avoid overloading you 
with information here, but just understand that these two figures are 
important for determining audio quality and that once you’ve started 
recording material, you should continue to record that whole session 



with the same settings.  We’ll never want to use settings below 44,100kHz and 16 bit and doing so will 
severely compromise your audio quality.   

Next, check the Audio Interface settings.  Typically these don’t change, and as long as you turned 
everything on in the right order, the interface settings should already be set.  But there are several ways 
we can configure Cubase so it would be good to get into the habit of checking these every time you start 
a project. 

First of all, we’ll check that we are using the correct audio interface drivers.   

You can do this by going to Devices > Device Set up.  
Under VST Audio System (selectable in the left side of 
the window), you should see the ASIO Driver – this 
needs to be set to Yamaha Steinberg FW ASIO.   

Under the Yamaha Steinberg FW ASIO tab selectable 
in the left side, make sure Direct Monitoring is 
checked.  

 

WE’RE FINALLY READY TO GET STARTED… 

There are two main windows that you’ll use in Cubase.  The Project Window and the Mix Window.  The 
Project Window is where you see and edit the wave forms of the audio that you record.  You can also 
use the project window to set up your recording channels and lots of other things.   

The mix window is where you mix, or blend the audio tracks you’ve recorded. It is set out like a 
conventional audio mixer.  It’s more useful for multi-track recordings.   

Lets take a closer look at the Project Window… 



 

This is from Nuendo not Cubase, but the look is similar, and functionally they are identical at this point. 

1. The Inspector. If you have a single track selected, you’ll see a virtual channel strip for it called 
the inspector.  It shows the inputs, outputs and gives you easy access to effects processing 
through Inserts, Equalizers and Sends.  The Channel button shows you the mixer channel exactly 
as you would see it in the mixer window. 

2. The Transport Bar.  This is where you start and stop recording, rewind, fast forward and do 
several other tasks.  Basic controls from the transport controls (Record, Play etc) also appear at 
the top of the screen.   

3. An audio track.  This is what you record onto.  You’ll see the audio waveform appear as you 
record. 

For your set up, you will be using two stereo audio tracks to record the concert.  To set that up, focus in 
on the inspector. Here’s what everything does -  

Fader – this will change the volume of this channel.  It won’t change the level of 
audio that gets recorded – that can only be done with the gain knob on the 
MR816x.  This will change the level of volume that you hear through the speakers 
for this channel.  It will also impact the level that gets recorded when you bounce 
down.  We’ll deal with that later.  

Panner – this will change the position Left to Right.  If you have two separate mono 
channels you’ll have one panned hard left, and one panned hard right.  With a 
stereo channel, there’s no need to set this as it will automatically be panned to hard 
left and right.  You can change this though if you need to, and you’ll find out about 
that when you do more advance recordings. 

Input – this determines where the sound for this channel comes from. If you set up 
as above, with microphones plugged in to inputs 3+4 on the back of the MR816, this will need to be set 
to MR816x –In 3/4 for the stereo pair, and 5/6 for the catwalk pair. 

Output – this determines where the sound for this channel gets routed to.  MR816x Out 1/2 is the main 
output.  Output routing can get complicated pretty quickly, so for now, just know that you’ll always 
want the output to be MR816 Out 1/2. 



GETTING READY TO RECORD 

Once you've set up your channels, you need to record enable 
them so that when you hit record, audio will be recorded to 
them. Before doing this, it's worth saving again. Ctrl+S or File > 
Save will save your file. 

The Record Enable icon is a circle, with a black dot in the 
middle, like in the image to the left.  It appears both on 
the track itself, and on the inspector.  It will be a grey/blue 
colour when it’s off, and red when it’s on. 

Click this icon and it will turn red, and the track will be 
record enabled.  Now, whenever you hit record, this 
channel will be included in those that record audio.  

To the right of the record enable button is a monitoring button.  
Again, this is blue/grey when it is turned off.  It will turn to a 

kind of orange colour when turned on.  This should be turned on while you record, and off while you mix 
or listen back.  Basically, it allows you to monitor the input of this channel while you’re recording. If it’s 
not selected, you won’t hear anything you record on this channel. While playing back, you actually don’t 
want to monitor the input.  You want to monitor the output.  So, turn the monitoring button off when 
listening back to tracks. 

If you make a noise in the Recital Hall, the level indicators should show you that your two mic channels 
are working correctly. If you don't get any sound, go back through the steps and make sure you 
haven't forgotten something. Although Cubase set up is fairly automatic from session to session, it is 
possible that inputs or outputs don't set themselves up the way you need them. If you don’t pick up 
audio, it won’t get recorded.  There is no way to get this back at a later date.  So make sure it’s working. 

If you get a chance to do a sound check with the performers, you can trim the gain knobs of the MR816x 
to suit the performance. What you need to be able to do this is for the artist, or artists to perform at the 
loudest they will perform during the show, while you increase the gain levels until the music clips. 
Reduce that level by about 15% to allow for the fact that people often perform at a different volume 
than they sound check. I wouldn't advise going past the 1 o'clock position for a concert performance, 
because the applause itself will clip and while that's not as much of a big deal (the sound of applause is 
actually fairly similar to the sound of digital distortion), we should avoid it if possible. 

If you don't get to do a sound check, here's a general rule of thumb for levels... 

 Solo performers - 1 o'clock 

 Small ensembles, except brass - 12 o'clock 

 Accompanied singers - 12 o'clock 

 Small brass ensembles - 11 o'clock 

 Large groups (wind ensemble, chamber orchestra etc) - 10 o'clock 

Always monitor your levels to see if you're in the right ballpark - remember that a quiet work will be 
much quieter than a louder one... it might sound obvious, but if the performers start with something 
quiet and you bring their levels up, you might find it clips when they do a louder piece later on. Since 
you're attempting to capture a realistic performance, you want to avoid changing the gain levels as 
much as possible once the performance has actually started. A quiet performance will see a much lower 
level on the meters than a loud performance. 



HIT RECORD 

So, with your setup done, you just need to wait for close to the start of the performance, and hit Record 
on the main transport bar to actually start recording. If it’s been more than a few minutes since you set 
up your session, give the transport bar a little extra time to start recording (if the hard drives have gone 
to sleep they require this extra time).  It’s always better to record too much than miss the start!  You can 
edit out what you don’t need, but you can’t add in what you didn’t record. 

WHAT TO WATCH FOR AS YOU'RE RECORDING 

As you record, you should be able to see the wave form being created in the project window. 

 

If you need to change the input gain levels, it would be worth putting in a marker so that you know 
where that happened. You can compensate the entire performance later. To put in a marker, press Shift-
M. You can give your marker a name, or leave it blank, and then hit the enter button again. 

You can use the Mix window to monitor the level of your tracks, and see when tracks clip.  You’ll see an 
indicator appear under any channel that clips. 

 

You can reset the clip indicator by clicking on it. 



A red clip indicator is okay if it's a fast transient like applause or a loud drum hit, but should be avoided 
where possible. If it happens more than twice, you’ll need to reduce the pre-amp gain. If it keeps doing 
it, you definitely need to reduce the pre-amp gain! 

AT THE END 

Hit STOP on the transport bar, and then press Ctrl + S or go File > Save.  

To exit out of Cubase, hit the X in the top right corner.  You may need confirm that you wish to save 
changes before it actually exits completely.  

EDITING 

When we edit our regular concerts, we typically do a static mix.  That is, without changes in our fader 
position as the concert progresses. This retains the original dynamics of the performance. To ensure our 
output file is just as it is inside Cubase, the master fader should be at unity (zero).  You do all this inside 
the mixer window.  You can choose the mixer window by hitting F4 or by going Devices > Mixer.   

Back to the project window, and we’ll first deal with tidying up the tracks. A typical workflow will be –  

 Normalize your project 

 Edit the length of your tracks 

 Add fade in and fade out to each track 

 Export your tracks 

For very dynamic performances, you may also wish to use a tiny bit of compression/peak 
limiting. This requires some careful use, so if you’re not sure about how compressors work, do 
not use this. 

As an added first step, you may wish to copy your recording to a different track or use a new 
project file.  Cubase works non-destructively with your files, so even if you mess something up, 
your project wave files can be restored to their original, however, the easiest way to get back is 
simply to edit from a copy.  You can copy your audio by setting up a new stereo audio track 
(right click in a blank space in the project window and choose New Audio Track.  Hold down the 
Alt key and drag your audio file from its original location to the new audio track. If you have 
multiple regions in your track, you’ll need drag them all over in the same way. We’ll edit from 
this one, so press the M button (mute) on the original track so that it doesn’t interfere.  

Normalize 

If you have multiple regions in your project, select them all and bounce them to a single region. 
You can do this easily by going to the very end of your project, holding down the mouse past 
the end of the project and dragging to the beginning of the project. Remember, do this just on 
the track you’re working on. Now go to Audio > Process > Bounce Selection.  We do this so that 
when we normalize, it normalizes the whole concert as a single event, rather than individually 
as dictated by the separate regions. 

When prompted if you wish to replace the existing selection, say yes.  This does not destroy 
your original file. 

With your single file selected, now go to Audio > Process > Normalize… 



 

In the dialog box that appears, click on the black box, and change the “Maximum” to -0.5dB.  
Then click on process. 

 

Edit Your Tracks 

Next you need to cut your tracks up to remove silence and audio that you don’t want 
on your final CD.  You’ll cut your audio into regions which will represent the individual 
tracks of your CD.  Use the scissor tool to cut your tracks roughly into regions by 

track/song/movement etc. 

 

 

When you have a region selected, you’ll see five handles.  Bottom left and right are squares – 
these allow you to change the start and end points of your region for accurate trimming of your 
audio tracks.  Top left and right are triangles. Drag these to create standard fade ins and fade 
outs.  The square handle top middle allows you to alter the volume of the selected track. 

Edit each region so that the silence at the start is between 0.25 and 0.5 seconds.  If there’s a 
breath or sniff at the start that’s important to the track, go 0.25 before that.  Edit the end of 



each region to allow up to four seconds of silence after the music has stopped.  You may need 
to cut shorter than this so as to remove undesirable noises, but be sure to retain all the room 
decay sound.  Make sure the edit sounds natural.  You can add silence at the end in other ways 
if noise means you need to cut off before the four second point.   

When you put tracks onto a CD they must start and end with a zero volume (infinity).  If they 
don’t, they will be heard as clicks at the start or end of the track.  The easiest way to make sure 
this happens is to use fade ins at the start of each track, and fade outs at the end. Fade ins and 
outs need to be at least 10ms to be useful.  That’s not hard to achieve!  You can create long or 
short fades depending on the needs of the track. 

Applause 

There is no standard for dealing with applause out there in the real world.  While some artists 
may like to hear their entire applause at the end of tracks, it can be tiresome to listen to if 
you’re anyone but the artist!  As a rule of thumb, lets work to the following standard –  

- Small audience: 5 seconds applause, 5 seconds fade out…  10 seconds applause in total. 
o Last track – 8 seconds applause, 8 seconds fade out…. 16 seconds applause in 

total. 
- Large audience: 10 seconds applause, 10 seconds fade out…  20 seconds applause in 

total 
o Last track – 15 seconds applause, 15 seconds fade out… 30 seconds applause in 

total. 
- If a performer asks you to keep all the applause on a recording, do so.   

Movements 

Dealing with movements is tricky.  Sometimes there are long pauses between movements, 
other times they practically go straight into each other.  Use the performance as your guide, but 
make gaps even between the movements of a work, and never include more than 5 seconds of 
“silence” before a fade out.  A gradual fade out is preferable to an abrupt one – you will hear 
the difference in the ambient noise. A fade of one second is good.   

Export 

When you use the export function in Cubase, the region that you wish to export is defined by 
locators at the start and end of your selection. When selecting regions, you can easily place 
these locators by selecting the region then hitting ‘P’. You will see the region selected appear in 
the ruler at the top of the project window.   

 



When you have done this, you can manually move the start and end if you need to, by dragging 
the triangle locators, to provide additional silence at the start and end of your track.  Just be 
sure not to infringe on the next region or this will become part of your export.  

 

When you’re ready to export, click File > Export > Audio Mixdown. A dialog box like the one below will 
appear.   

 

Give your track a name (or number) that will be meaningful to you when you add the tracks to a CD 
listing (I typically use 01, 02, 03, etc…), choose a path (start with the Project Folder, and create a folder 
within that called CD tracks), and choose the file format (Wave File). 

In Audio Engine Output choose the destination sample rate and bit depth – remember the sample rate 
will be 44.1Khz for and 16bit for CD. Uncheck the Pool and Audio Track boxes under Import into Project. 

Click Export and your file will be created. 

Repeat this export process for each track. 

  



CREATE A CD 

Use Roxio Creator Starter to create an audio CD of your tracks. 

Double click the icon on the desktop. 

 

Click the Burn Audio CD’s icon. 

 

Click the Add files button and choose the files to add, or simply drag the 
files from where you stored them. 

When you’ve added the tracks, you need to make sure the Pre-Gap is 2 
seconds.  This creates a better flow for the CD.  Go through each track 
and make the Pre-Gap 2 seconds. 

Check the order of your tracks, insert a blank CD and click the Green 
arrow to start the burn. 



When you’ve burned your CD, listen to at least the start and end of each track to ensure everything is as 
it should be. 

CD RECORDING STANDARDS 

School of Music recordings should have some kind of consistency, so I would like all recordings to be 
submitted with the following features - 

 Each track should have a lead in time of no more than 0.5 seconds. When I refer to lead in time, 
I am referring to the actual audio file. A CD will by default put a 2 second silence before the start 
of each track, and while it’s possible to override this, I would like it to be kept, and for the audio 
track to reflect that two seconds. A lead in of 10ms is enough to avoid playback problems, but 
between 0.25 seconds and 0.5 seconds is ideal. The start of the track may be considered to be 
the breath of a wind player, the sniff of a string player. Keep in the human element, but avoid 
oodles of silence at the start of each track.  

 Normalize the entire performance to -0.5dB. Do not normalize individual tracks. If you have 
spoken introductions, these are likely to be very quiet. You can normalize the introductions 
separately - normalizing to -12dB should give you a good bit of boost without introducing too 
much background noise.  

 Applause - Small audience: 5 seconds applause, 5 seconds fade out…  10 seconds 
applause in total. 

o Last track – 8 seconds applause, 8 seconds fade out…. 16 seconds applause in 
total. 

 Applause - Large audience: 10 seconds applause, 10 seconds fade out…  20 seconds 
applause in total 

o Last track – 15 seconds applause, 15 seconds fade out… 30 seconds applause in 
total. 

 Applause – special: If a performer asks you to keep all the applause on a recording, do 
so.   

 Include two seconds of silence at the end of each track.  
 Split works that are in more than one movement except where doing so would cut off the audio. 

This would be the case if the performers start the movement before the decaying room sound 
has finished for the preceding movement. Don't include long silences or tuning up.  

 Complete your editing of a performance within one week of that performance, and hand it to 
the Music Technologist who will review it. Once it has been reviewed, the Music Technologist 
will delete the files from the computer's hard drive. So, if you have any reason to keep it past 
this review (if you wanted to do a different cut for the performer for example), note in the 
session folder name - DO NOT DELETE.  

LABELLING YOUR CD 

When you’ve created your CD, label it with the name of concert and/or principal artist, the date of the 

concert, the venue, and indicate how many discs form the complete set.  See the example below. 

 

 

 

 

Richard Blenkinsopp 

“Live” 

 

 

31st February, 2043 

D F Cook Recital Hall 

 

 



CABLES AND CONNECTORS 

In the professional audio world, there are three main types of analogue cable connection that you’ll 

come across, and one of those isn’t really professional, its just common.  These are described below –  

XLR 

These are XLR connectors – Female on the left and Male on the right.  

Typically, the male side sends the signal and the female side receives it.  

This isn’t always the case, but is usually, so knowing this should help 

make things quick to set up. These are the most common kinds of 

connection in the studio.  They are used for virtually all microphones, 

most mixer to speaker connections, and to bridge long connections for instruments like guitars and 

synthesizers, with the use of a DI box. It’s a very robust type of connection and the physically most 

secure type of connection in the studio. Use it wherever possible. 

¼” Jack Plug/TRS/TS 

Jack plugs come in two main flavours, both shown here – on the left a TS plug 

and on the right a TRS plug.  TS stands for Tip, Sleeve and TRS stands for Tip, 

Ring, Sleeve.  The former is a mono unbalanced connector and a TRS is either 

a stereo unbalanced or a mono balanced connector. The difference is that 

ring that goes between the tip of the plug to the sleeve (the long shank). It is 

used for fairly short cables runs only connecting many types of equipment to 

a PA or recording system. Guitars and keyboards use them. Balanced connections are intended to help 

combat interference problems. The male connector (the plug) tends to go on the cable at both ends and 

the female connector (the jack) tends to go on whatever hardware is being connected.  The female end 

is usually only seen on cables as a way of linking multiple cables together. Although TRS cables can 

theoretically be used in the same way as XLR cables, they are rarely used with microphones or any other 

equipment that requires that phantom power be sent through the connector. The physical shape and 

arrangement of the connector would make this a fairly dangerous type of connection to send phantom 

power through. TS cables degrade audio signals over even moderately long cable lengths, so if needing 

to connect a TS connection to a PA system, its important to use a DI box close to the instrument to 

convert the line level signal to a mic level, and at the same time change the connection from TS to XLR 

to carry that signal the rest of the way to the mixer or audio interface. The picture shows male 

connectors.  The female connectors are always on the equipment you’re connecting, regardless of 

whether you’re sending or receiving a signal. 

RCA  

This is the consumer cable of the bunch.  It is used on most CD/DVD players 

and recorders and other consumer grade equipment.  An audio only cable 

will typically come with two connectors on each end – a white or black 

connector and a red connector. Although it doesn’t matter which colour 

gets connected to which side, its always best to think  that red is always 

right.  Black or white is always left.  A yellow connector is often used for 

video (the connection is called composite video).  It can also be used to transmit audio. Since these 

cables only have two wires running through them, each cable can only transmit a mono unbalanced 

signal. That’s why you typically see them in pairs.  They should not be used for long distances.  The end 

http://upload.wikimedia.org/wikipedia/commons/9/91/Composite-cables.jpg


shown in the picture is the male end.  The female end is always on the equipment regardless of whether 

its sending or receiving the signal. 

Using a Turnaround or Gender Changer 

The primary connection type we use in recording is called XLR. The history behind the name is 

complicated.  It’s on Wikipedia if you really want to know! Like other audio connectors, it has a male and 

female end, but unlike most connector types, the male end is used to SEND a signal, and the female end 

is used to RECEIVE a signal.  There are exceptions to this, but it’s good to get into the habit of 

remembering that male normally sends and female normally receives. 

 

XLR connectors – Female (receive) on the left, Male (send) on the right. 

Most XLR cables have a male and a female end for what should by now be obvious reasons – the signal 

is RECEIVED by the cable, flows through and then gets SENT on to somewhere else.   

From this, we should be able to deduce that –  

 Microphones have male connectors 

 Mixer INPUTS have female connectors 

 Mixer OUTPUTS have male connectors 

 Speakers have female connectors 

Our snakes that carry signals from one place to another and back again use the same concept, so at the 

mixer end of the snake, you’ll have a whole ton of male connectors (typically 16-24) that connect to the 

inputs on the board, and a small number of female connectors (typically 4) that connect to the outputs 

on the board.  At the stage end of the snake, there are a whole ton of female connectors that connect to 

microphones etc, and a small number of male connectors that connect to the speakers.  

Sometimes we run into a problem that we need to return more than four signals to the stage – typically 

when we use more than two speakers plus two stage monitors.  We get over this by changing one of the 

24 male connectors to female at the mixer end and one of the 24 female connectors to male at the 

stage end.  We do this using turnaround cables.  These simply have the same connector gender on 

either end of a short cable.  We have a few female to female and a few male to male XLR cables on the 

rack for this reason.  If you can’t find one, look in the top right drawer of the cabinets.  Some are so 

short they don’t fit on the rack. 

One last point… 

All projects must be recorded on the CD projects log so that we know what’s happening and 

what isn’t. 



EXTRA NOTES 

What about Suncor? 

The process for recording in Suncor Hall is basically the same as in Cook, except that the microphones 

are not permanently suspended from the ceiling – they need to be set up before use. We also only use a 

single pair of microphones – there will be nothing equivalent to the catwalk mics that we use in Cook. 

Set up will typically take you an extra ten minutes to do because you’re going to make the cable runs 

really tidy.  You can grab a pair of microphones from the cabinet inside the door to Suncor Control 

Booth.  They’re in a black case.  Grab two long XLR cables and a t-bar too.  The t-bar is a black piece of 

metal, with two bolts sticking through it.  You’ll use this to hold two microphones on a single 

microphone stand. Use an ORTF microphone configuration (this is the same as the main mics in Cook 

Hall, and the diagram below).  

ORTF microphone configuration.  The distance and the angle are not an exact science.  

Somewhere around 90-110° will get you there, and the span from the edge of your 

thumb to the edge of your pinky will generally do for the distance between the mics. 

Perhaps of more significance, is placement in the middle of your performance set up, 

left to right. 

 

 

  



COMPLEX RECORDING SETUPS 

So far, we have looked at simple four track recording.  This is what we use for concert recording. 

MICROPHONE SET UP GUIDE 

PART 1 - INTRODUCTION 

For serious recording of classical instruments, either as soloists or as ensembles, we typically choose a 

multi-microphone set up, using close microphones for attack and definition, and room microphones to 

add ambiance and richness to the sound. This guide will help you choose the right microphone set up for 

close miking, and give you some insight into your options for room miking.   

Before we get started, lets talk a little about sound… 

What is Sound? 

Sound is a mechanical wave caused by the vibration of an object that is transmitted through a solid, 

liquid or gas that is within the range of hearing. 

There are two types of mechanical waves – transverse and longitudinal. Transverse waves oscillate 

perpendicular (90 degrees) to the direction of the energy and longitudinal waves oscillate in the same 

direction as the energy transfer. Sound is typically a longitudinal wave – if you think about how a 

loudspeaker works, it pushes and pulls the cone and the sound emits in the same direction.   

In audio software, sound is represented as a transverse wave.  The reason is because it’s much easier to 

see what’s going on visually in a transverse wave over a period of time.  You might not see this now, but 

eventually you will. 

 

Why do we care?  Well, it helps you to understand what’s happening with sound and why it is affected 

by objects in the way that it is.  It also helps you to relate what you see on screen when you record to 

what is going on in the space that you’re recording in. Sound represented by transverse waves have all 

the information that they’d have as longitudinal waves.  It’s just easier to read. 

Sound vibrations are set up by musical instruments in different ways, and an understanding of where 

those waves are produced and how they’re affected by the body of instruments can help you to 

determine good microphone placements when you’re recording. If you know how sound is generated, 



and propagated, you shouldn’t need to learn specific microphone set up techniques for every 

instrument. 

For classical music (and some other forms of music), a purest approach to recording is usually taken, 

whereby microphones capture the natural full sound of a musician or ensemble in its environment.  This 

is in contrast to most pop recording where it is usually more desirable to record the driest sound that is 

not affected by room acoustics.  This latter approach does allow for more definition or clarity and effects 

control which helps to define rhythmic and certain creative elements better, but it comes at the cost of 

some richness to the sound. 

Timbre 

Timbre is what gives each musical instrument its unique character.  The tonal qualities of musical 

instruments is important to listen for when you are setting up as microphone placement can 

dramatically alter what we hear in a recording, and in live sound reinforcement (A PA system).  For the 

latter, we have to balance other environmental considerations such as feedback which can be 

introduced by our microphones picking up room reflections, and the sound quality is usually a 

compromise. But in recording, we can place microphones wherever we need to, to capture the most 

natural or pleasing sound without this issue. There are at least ten valid positions for miking up an 

acoustic grand piano.  Each set up changes the tonal characteristics and the definition picked up by the 

microphones.  Things that determine what kind of recorded sound you are aiming for include  

- Traditions – positions and techniques other engineers before you have used for similar material. 

- Repertoire – period and style will determine how much definition you need in your sound. 

- Equipment – recording and musical equipment will determine where your microphones will 

capture the best sound. 

There are three main areas that affect the timbre or tonal quality of a musical instrument when picked 

up by a microphone –  

- The exciter – this is where the initial vibration is set up – the point of contact of the bow or 

finger with the strings of a violin or guitar, the lips of a brass instrument, reeds of a wind 

instrument or the beater of a drum or piano. 

- The resonator – the body of the instrument. 

- The environment – the room could be considered an extra body – its working in the same way 

as the resonator. 

Microphones are usually placed where the best mix of these three elements happens - 

Exciter Brighter More attack/definition Less Echo/Ambience (Reverb) 

Resonator    

Environment Richer Less attack/definition More Echo/Ambience (Reverb) 

However, there are other elements to take into consideration.  Typically classical recordings emulate the 

ensemble sound from an audience perspective. So even though setting up microphones on a piano 

above the hammers would produce a bright but rich sound, and give a great stereo spread, it wouldn’t 

produce a realistic emulation from the audience perspective. Great for pop, but not so for classical 

recording. 



Balance 

To a large extent, we have an easy job to do with balancing the sound we capture.  We expect our 

classical ensembles to perform acoustically, and they are trained to be well balanced within the 

ensemble.  If we set up a pair of microphones in the approximate location of the audience, we should 

get a good representation of what the audience hears, especially if we use a microphone technique that 

mimics the human hearing mechanism.  When we set up additional microphones however, we must 

determine the balance of a microphone within the ensemble, remembering that the ensemble includes 

the environment. We can use the mixer in our DAW to balance the various microphones that we have 

placed.  Bleed of other instruments into microphones is to be expected and somewhat unavoidable, so 

listen to each microphone when it has been set up to make sure a distant instrument does not 

overpower a close one and that you don’t have phasing issues (more about that in a moment).  In other 

words, make sure the sound from each microphone gives a good balance of what it is supposed to be 

picking up. When using two microphones during a concert, the balance between the ensemble, the 

room and the audience is very important as it can’t be changed in post production. In multi-channel 

recording, the balance is determined more during the mixing phase.  However, the set up of 

microphones is just as important in order to make balancing possible in post production.  

Acoustics 

So far, we’ve referred to Acoustics as Environment.  They’re interchangeable terms, but Acoustics is a 

more sound based term, so lets stick with that from now on.  Any point within any room has unique 

acoustic properties.  Even if you put strings on a trumpet, we wouldn’t expect it to sound the same as a 

violin, and we shouldn’t expect two different rooms to share the same sound either.  Room surface 

materials and the positions of microphones within a room has a large impact on the sound we will get 

from that location.  The instruments we are recording, in particular how loud they are, will also have an 

impact. Experience will guide us to the best location within a room to use as a starting point for 

microphone set ups. Our two primary recording rooms are Cook Hall and Suncor Energy Hall.  They 

sound very different, and depending on the group, one might be better suited than the other.  When 

setting up microphones its important to listen to how reflections from the room interact with the direct 

sound from the instruments. Specifically we need to listen for two things –  

- Reverberation: This is the room character. Reflections/echo. None is bad, some is good, too 

much is bad.  Knowing where to put your microphones to get the right balance comes with 

experience, and getting advice from those that have done it before.  If you have too much room 

sound, move your microphones closer to the instruments you’re recording.  If you have too little 

room sound, move the microphones further away.  Changing the ensemble’s position relative to 

the reflecting surfaces (walls typically), can also change the reverberation, though its unlikely to 

significantly change the apparent acoustic space. For recording purposes, its easy to put in 

additional microphones that allow us to capture the room sound and the close ensemble sound 

somewhat separately.  This allows us to make the call on balance after the fact.  For concerts 

though, it is usual to use as few microphones as possible so that we don’t interfere with the 

audience experience so we need to get it right first time with a single pair of microphones. 

- Phase Cancellation:  This occurs when a signal is received from two places with a slight delay 

that interferes with the waveform. It can be caused by two microphones picking up the same 

signal, or by a single microphone picking up a signal from two places (usually direct, and 

bounced off a surface like the floor or a music stand). In both cases, it’s the difference in delay 

of the two signals that causes phase cancellation. The result is a partial or complete cancellation 

of the wave form that at best can make instruments sound thin or unnatural, and at worst can 



completely cancel out sounds. We check for phase cancellation in a couple of ways depending 

on the equipment we are using – we’ll look at that hands on. Phase cancellation is corrected by 

moving microphones so that the delay no longer causes a cancellation of the signal. It may also 

require musicians to move. 

Noise 

Noise is almost always bad.  It can come from several sources, and sometimes you can do something 

about it, and other times you can’t.  So it’s important to listen for noise and be able to determine 

whether or not you can do anything about it. The most common source of noise in a high quality system 

is environmental.  Air handling units, air conditioning, heaters, mechanical equipment, even traffic, can 

cause noise and spoil a recording.  Out of our two main recording spaces, Petro-Canada Hall has a worse 

noise problem than Cook, especially with traffic (and construction), and with the air conditioning. The 

lights can also create a lot of noise.  The latter two, you can do something about.  You can have the air 

conditioning turned off in the hall by phoning the Utilities Annex – the phone in the sound booth, and at 

my desk have the number programmed – just hit the down arrow on the phone until Utilities Annex is 

highlighted then hit Dial.  Be sure to have it turned on after your session is over so that a relatively even 

temperature is maintained in the hall. The light noise can be prevented by avoiding using the house 

lights, ensuring as few lights as possible are lit, and that all those that are lit, are lit at 100%.  The noise 

they create is a ringing sound.  Be aware that if you change a lighting preset, it can cause the lights to 

click occasionally as they change temperature and expand/contract.  So, if possible, set the lights even 

before you start setting up so you give them a chance to acclimatize to their new temperature. Traffic 

noise is a problem as is construction noise.  This can’t be avoided other than rescheduling a session late 

at night.  Make a judgement as to whether it interferes with what you’re doing and advise the artists if 

you think they should re-schedule.  If in doubt, record a sample of the group, and have them listen to 

the result to see whether the noise is acceptable to them.  In most cases, it is tolerable.   

Other noise comes from the incorrect setting of gain structure within the recording system.  It’s caused 

by the equipment itself being used at settings it wasn’t designed to be used at.  We’ll look at gain 

structure when we do our next set up, so we’ll come back to this. Typically electronic noise sounds like 

white noise (like the ocean) but can also sound like a fax machine when connecting certain electronic 

devices to our set up! 

Microphones – types, uses, precautions, technical requirements 

Dynamic Microphones – these are the most popular kinds of microphones. They are ideal for live sound 

reinforcement because of their resistance to feedback, their general ruggedness and their simple 

requirements to make them work!  We have several types of dynamic microphones – Shure Beta 57, 

Shure SM57 and Audio Technica AT814.  Their sensitivity and sound quality is not usually as good as that 

of other types of microphones (this is what makes them less prone to feedback), which makes them less 

well suited to recording situations. You can plug a dynamic microphone straight into any mixer in the 

building without any power requirements. Dynamic microphones work on the same principle as 

loudspeakers, only in reverse. In fact, you can use loud speakers as microphones, and in some instances, 

loudspeakers actually make really good microphones!  Although I wouldn’t recommend you play 

hackysack with them, a dynamic mic should typically survive a fall from 5-6 feet. You still need to be 

careful with them, but if disaster happens and they do take a tumble, they’re not ready for the garbage 

yet. 



Condenser Microphones – These are the most common microphones used for recording. We also have 

some we use for live sound, but they are typically recording microphones.  Condenser mics are much 

more delicate than dynamic mics.  They are likely to be killed if they are dropped from 4 or 5 feet, and 

since the ones we use range in cost from about $500 to about $1200, you need to handle them with 

extreme care and attention.  There are numerous benefits to condenser mics, primarily an increased 

sensitivity (which leads to an overall higher quality), and they are available in polar patterns other than 

the stage standard, Cardioid (pronounced cardy-oid).  Hey, polar what now?  Okay, the pattern of the 

microphone diaphragm determines where the microphone will pick up the sound.  Common types 

include Cardioid which picks up a 131 degree field in front of the microphone, to Omni which picks up a 

360 degree field all around the microphone.  Another common type is figure-8 which picks up on the 

front and back, but not on the sides.  Why, you ask yourself?  Well, sometimes its good to reject sound 

coming from certain directions, and different polar patterns help you to achieve this.  Also, different 

patterns are required for different stereo miking techniques.  We’ll deal with that separately.  For most 

recording purposes relating to classical recording, you can simply go by a rule of thumb that Cardioid is 

very universal and by far the most useful pattern – it can be used for practically every microphone use 

we have.  Omni would be second most useful and would be particularly useful in picking up the room 

sound in addition to our instruments.  It can produce a more open sound on things like piano, but 

beware that because it picks up all around, there are set up considerations that we must think about to 

avoid problems with noise and in a multi mic set up, with  phase cancellation. 

The following image doesn’t show all the polar patterns, but is by far the best visualization I’ve ever seen 

of how polar patterns work in the real world.   

 

…and this is the full range of patterns we can achieve using the microphones we have. 

 

Condenser microphones require a power supply called phantom power in order to work.  This typically 

comes from the audio interface or the mixer, and is often a button that says +48v or Phantom.  The 

recording interfaces we use daily (the Digi 002R and the Digi Control 24) have phantom power turned on 

permanently, so you don’t need to think about it. Incidentally, dynamic mics which don’t need phantom 

power are not damaged when it is turned on, on our console.  For live sound using the Soundcraft 

board, you need to set phantom on for any channel that you need it – we’ll discuss that in more detail 



when we get to it. We have lots of different types of Condenser microphones – AKG C414, Neumann 

KM183, KM184 and Audio Technica AE3000 and AE3300. The AKG and Neumann microphones are high 

end, and are only used for recording.  The Audio Technica mics are stage condensers and are used for 

live shows.  They are designed to have better quality than the dynamic mics we have, but with some 

feedback resistance. The AKG C414 and the Audio Technica Mics are called Large Diaphragm Condensers 

(LDC’s), while the Neumann microphones are Small Diaphragm Condensers (SDC).  This simply refers to 

the size of the diaphragm inside the microphone that picks up the sound.  Typically a LDC would have 

somewhat better sensitivity to low pitched sounds since its larger size lets it vibrate at slower speeds.  In 

general, this means that they are typically better suited to low pitched instruments.  In practice, all of 

the recording condenser mics we have are very well designed, and their use can be interchangeable.  

Other types of Microphone – there are numerous other types of microphones, most commonly ribbon 

and PZM.  We don’t have any ribbon microphones which are incredibly delicate and have a very limited 

use. They are used in recording studios for solo musicians (really good on vocals and trumpets!). They 

generally have a figure-8 pick up pattern due to their physical design.  We have a couple of PZM mics, 

but don’t use them except in very rare situations.  PZM’s (Pressure Zone Microphones) are placed on a 

hard surface which acts as the microphone pickup.  Although they have their uses they normally pick up 

too much noise from environment and from the surfaces they’re placed on to really work...   maybe we 

should experiment with them.... one thing to note with ribbon mics is that some can be damaged if 

phantom power is enabled on a channel that they are plugged into. 

Wireless Microphones – we have one wireless microphone system that is available to use as a lapel mic 

or a headset mic.  They are awful.  Avoid wherever possible.  If you do ever need to use them, they 

require batteries, so never offer them up on the fly. Both lapel mics and headset mics are condenser 

microphones (typically in a hypercardioid pattern), so while their design is intended to combat feedback 

somewhat, they are fairly prone to it because of the location they normally occupy on stage – especially 

the lapel mic which is right out in the open! They also have lots of handling noise.  They are not suitable 

at all for recording purposes, and have very limited live sound use. 

  



PART 2 - CLOSE MIKING 

Brass 

 
Trumpet    Trombone  

 
Tuba/Euphonium 

 

The AKG C414 is a good mic to use on all brass.  The 

Neumann KM184 would be good on trumpet, not so 

good on the rest. Use the direct (or as indicated in 

pictures – strident) position only for pop recordings and 

watch the levels – brass can get very loud!  For classical, 

it has to be off axis for a richer, darker sound. Start at a 

distance of 3-4 feet from the instrument. 

 

 

French Horn 



Piano 

First choice for classical recordings would be an ORTF 

pair, preferably Neumann KM184’s on a t-bar placed in 

the piano nook (around where the lid catch is).  Move 

towards the hammers for more attack or away for a 

darker sound. Start as close as the lip.  Move out to 

reduce boominess or for a lighter sound. 

 

 

 

 

 

 

Strings 

 

Violin/Viola   Cello   Bass 

As far as microphones go, the Neumann KM184 is your best bet on violin and viola, and the AKG C414 

on cello and bass. Start 2-3 feet from the instrument.  Move further away to avoid finger noise or for an 

airier sound or closer to maximize separation with other instruments. 

 

 

 

               

When the lid is closed and Any recordings (alternative) 

for pop recordings 

 



Guitar 

Guitar is treated differently to the other stringed 

instruments.  As a solo instrument, it is typically 

miked in stereo as shown.  Mics tend to go close 

to the instrument because it is so quiet.  Just be 

aware of noise coming from the strings when 

miking really close. Although string noise is 

popular in acoustic pop, its not really in classical. 

Voice 

Use AKG C414 in cardioid pattern, approx 4 feet in front 

of singer at chest height. Line up the mic so that the 

body blocks as much sound coming from the piano as 

possible. Normally singers won’t use music on a stand.  I 

wouldn’t recommend you have them hold the music like 

in the picture.  On a stand as far out of the way is good. 

 

 

 

Woodwinds 

 

Flute   Clarinet, Oboe, English Horn  Saxophones 

Neumann KM184 is the best choice for high woodwinds.  Although the bassoonist will normally be 

seated, you can use the same principle of positioning as for clarinet.  An AKG C414 might be a better 

microphone choice for baritone sax and bassoon. Start 2-3 feet from the instrument, except for a 

breathy flute sound which can be miked closer. 

 



Percussion 

There are way too many variables for percussion to give it justice here.  I would suggest using a “pop 

piano” style set up on bar instruments (marimba, xylophone etc.), and a close, slightly off axis position 

to the head/beater position for most other things.  Percussion can be really hard to record well, 

especially triangle and tambourine. 

Ensembles 

Its hard to predict how to record an ensemble.  We don’t have enough input channels to mic a large 

ensemble well, except for choirs, so you usually have to plan for those well in advance and make the 

most of what equipment is available.  It will always be a compromise here.  For choirs, the number of 

microphones you use depends on the size of the choir.  Note the distance shown in the picture below – 

mics tend to get placed between 1.8m and 3m apart.  Usually, the less mics you use the better, but you 

need to make sure the whole choir is covered, and well balancd. 

 

  



PART 3 - STEREO MIKING 

As mentioned in the introduction, in addition to using close microphones, we use room mics to pick up 

ambiance and a rich sound from the ensemble or soloist. In itself, the room sound doesn’t have enough 

attack or definition to be used alone for critical applications (though we still use it for concert 

recordings). There are numerous stereo miking techniques that can be fun to try out and use.  As long as 

you set up carefully, you can do little harm by trying any of them, but read the following carefully for 

precautions and recommendations. 

Stereo miking techniques can be split into three groups – co-incident, near co-incident and spaced.  

What do we mean by co-incident?  Basically, that the microphone capsules are in virtually the same 

space.  The most common coincident technique is called X-Y – see the diagram below. Near co-incident 

is where the microphone capsules are close to each other but not intended to be in the same space.  

The most common near coincident technique is ORTF – see below. Spaced means that the microphones 

are deliberately distant from each other. The most common spaced technique is actually called… spaced 

pair. 

COINCIDENT TECHNIQUES 

Coincident techniques are typically used to provide maximum mono compatibility. Useful if the material 

will be played on the radio, but less important for other mediums. It provides an accurate image, but 

tends to be a little on the narrow side which may prevent your recording from sounding airy and rich. 

The exception is Mid-Side (see below) which has a very variable image width. Because the microphones 

are very close together, it may be hard to pick up a large ensemble accurately using this technique. 

X-Y 

This technique uses two cardioids microphones with the capsules 

crossed at 135 degrees.  You don’t need to be there with a protractor… 

anywhere from 90 to 135 degrees should be fine. Neumann KM184’s 

work best for this set up. 

 

Blumlein (or stereosonic) 

Blumlein looks very simiar to X-Y – the biggest difference is the type of microphone 

you use.  It must be a bi-directional (figure-8) microphone.  For us, that means you 

can only use AKG C414, set to figure-8. Get as close to a 90 degree angle as possible. 

 

Mid-Side (M-S) 

Hard to see from this picture, but the Mid-Side technique typically uses two 

microphones – one cardioid pointing forward, and a bi-directional (figure-8) 

microphone pointing to the sides. This picture shows a purpose built MS 

microphone with everything built into one casing, but you can do it just as well 

with two mics.  You also need to decode the signal inside of Pro-tools when 

using this technique.  It’s fairly simple – you set up one channel for the cardioid and two channels for the 



figure-8.  The figure eight channels are panned hard left and hard right.  The cardioid channel panned 

centre.  Then you invert the phase of the right side figure-8 channel.  Now when you ride the faders for 

the figure-8 channels (together), you increase and decrease the width of the stereo field.  Very cool.  

Works nicely as a stereo microphone technique for classical guitar and would also be good to give 

spaciousness for anything unaccompanied. The only matched microphones we can use for this are AKG 

C414’s. 

NEAR COINCIDENT TECHNIQUES 

The Near Coincident techniques provide a wider stereo image that give a sense of air and richness to the 

sound that you don’t get with coincident techniques.  It’s less compatible with mono (more prone to 

phase cancellation). Like the coincident techniques, because the capsules are close together, this might 

not be the best way to capture a large ensemble. 

ORTF 

ORTF is a technique that was first used by the French broadcasting 

organization (Office de Radiodiffusion-Télévision Française).  It is our most 

commonly used stereo miking technique today. For this, we use a pair of 

cardioids microphones with a specific spacing (17cm) between the capsules, 

and at a specific angle (110 degrees). You can estimate 17cm by using the 

distance between the tips of your pinky and thumb when you span your hand as widely as possible.  Yes, 

this is approximate since it depends on the size of your hands, but saves carrying a tape measure around 

with you. Typically we use Neumann KM184’s for this technique, but we can use AKG C414’s too.  

NOS 

NOS was first used by the Dutch broadcasting foundation (Nederlandse Omroep 

Stichting). Although it looks very similar to ORTF in the picture, note the 

significantly different space between the capsules – 30cm instead of 17cm.  The 

angle is slightly less too – 90 degrees. Like ORTF, we use a pair of cardioid 

microphones for this.  Neumann KM184’s are the natural choice. 

SPACED TECHNIQUES 

Spaced techniques provide the widest image of all and are least mono compatible.  They are prone to 

phasing issues so need to be checked carefully for problems. They are the best choice for large 

ensembles, and for the largest feeling of spaciousness. 

Spaced Pair 

The spaced pair is the most common spaced technique.  Although the picture 

indicates the distance between microphones should be 3-10ft, we typically place 

them wider apart than this, and use the technique as much to record the space itself 

as the ensemble.  In Petro-Canada Hall, I typically use a spaced pair 20ft apart with 

good results. 

 

 



Decca Tree 

The Decca tree uses three microphones (sometimes more – typically an odd number), and is common on 

film stages and large ensembles such as orchestras.  There are no fixed 

measurements for this technique, but as seen in the image, typically will 

consist of two widely spaced microphones, and a third placed half the distance 

in front of the side mics as the side mics are widely spaced. For this technique, 

omni mics are used.  Even though omni mics pick up all around them, face 

them toward the side walls for the side mics and to the front for the middle mic.  Groups that use this 

technique often have special large brackets on a single stand for this to work.  We don’t have anything 

like this and would put them on three separate stands.  Typical distance between the side mics might be 

six feet (making the centre mic go 3 ft out front).  

The most common techniques we would use here are ORTF, spaced pair, and possibly Mid-Side. 
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TIPS FOR MANUAL SET UPS 

Knowing how to set up from scratch will help you troubleshoot any problem, and give you maximum 

flexibility in custom set ups.  Understanding some of the issues you need to watch for when creating a 

custom set up will help you to avoid recording issues that can’t be resolved in post-processing. 

The big difference between the interface in Cook booth and the primary interface in PC Hall, is that the 

one in PC Hall has built in hardware DSP. Even if you’re not planning to use the effects, its vital that 

Nuendo is correctly set up to avoid recording these DSP effects in with the microphone signal.   

Custom set up might include any combination of stereo and mono inputs that give you the best 

flexibility and ease of editing of any project. Multiple outputs allow you to set up a Cue Mix that lets the 

performers hear what they’ve recorded (or if required, hear what they’re recording as they’re doing it).  

So, everything we’re talking about here comes under the broad term of routing.  Lets get started. 

As mentioned above, there’s one big difference between the interface in Cook Hall booth (a Steinberg 

MR816x) and the primary one in PC Hall (a Steinberg MR816csx).  This is hardware DSP.  The chances of 

you wanting to use hardware DSP are very small indeed. They’re more for pop singers who we record at 

close range without lots of room ambience than for classical recording.  I’ll go through how to set up a 

Cue Mix later which you could use to provide the performer with a mix including DSP, but to keep things 

simple, we’ll just concentrate on the settings within Nuendo that prevent you from inadvertently 

recording DSP.   

In your mix window, you’ll find the inputs on the left, tracks in the middle, and outputs on the right.  The 

DSP settings are part of the input channels.  In order to show them, click the small arrow on an input 

channel to reveal the options dialog.  Choose Hardware.   

 

Above the mix faders, you should now see the hardware routing that will look like one of the three 

images below. 



 

Note the small rounded rectangle switch that sets the routing to one of three settings.  Click on the 

switch to change from one setting to another.  Looking closer at the whole image, you’ll notice that it 

shows you how the DSP signal will be routed.   

BYPASS – you’ll want this setting 99.9% of the time.  This will mean that DSP is completely bypassed.  No 

one will ever hear it.   

MONITOR – you’ll want this setting if you set up a Cue Mix and your performer wants to hear 

themselves with reverb and/or compression effects. 

RECORD – you never want this setting.  This will add any DSP to the audio input and it will be mixed and 

recorded with the audio input.  This cannot be undone, and once you record it, there’s no way to 

remove it.  That’s why you never want to use it. 

Check this setting for each input channel you have set up.  In theory you’ll be able to hear the 

difference, at least between the BYPASS and the other two settings.  In practice, you could miss it, so 

always check the settings visually. 

While on the topic of routing, lets take a closer look at the input and output connections.  This applies to 

both Nuendo and Cubase.   

We route inputs and outputs using busses. A buss becomes the container for any physical input or 

output on the audio interface.   They are globally set up using the VST Connections window – Devices > 

VST Connections. 

Tabs along the top of the VST connections window help you navigate between inputs, outputs and a 

whole bunch of other busses.  They are irrelevant – the only ones important to you at this point are 

inputs and outputs. 


